 ПРОФЕСИОНАЛНА ГИМНАЗИЯ ПО МЕХАНОТЕХНИКА И ЕЛЕКТРОТЕХНИКА 
“М. В. ЛОМОНОСОВ“   ГР. ДОБРИЧ

Утвърдил: 
Директор: .........................................

(инж.Сл. Иванова)
РАЗПРЕДЕЛЕНИЕ НА ЧАСОВЕТЕ ПО
Учебен предмет: ПРИЛОЖНИ ПРОГРАМНИ СИСТЕМИ
Професионално направление: 

523           ЕЛЕКТРОНИКА И АВТОМАТИЗАЦИЯ

Професия:

523090     ПРОГРАМИСТ

Специалност:


5230902   СИСТЕМНО ПРОГРАМИРАНЕ

клас Х 

за учебната 2009 – 2010 г.
по учебна програма, утвърдена със заповед № РД 09 - 838/20.06.2005 г.
на министъра на образованието и науката,

с хорариум в съответствие с училищен учебен план, 
приет на заседание на Педагогическия съвет с Протокол №  11 от 29.06.2009 г. 
и утвърден със Заповед № 586 от 14.09.2009 г.на директора на ПГМЕ „М. Ломоносов”

Изготвил: .............................. 

(инж. Красимир Дойчев)

Съгласувал:

ПД (инж. М. Дражева)
Разпределение на часовете  по  учебен план

	Уч. срок
	Учебен план на МОН - 2004 г.
	Училищен учебен план – 2009 г.

	І
	18 седмици  x 2 часа 
	36 ч.
	18 седмици  x 2 часа 
	36 ч.

	ІІ
	18 седмици  x 2 часа 
	36 ч.
	18 седмици  x 2 часа 
	36 ч.

	Всичко
	36 седмици
	72 ч.
	36 седмици
	72 ч.


    Разпределение по организационна форма

Клас: 
18

Групи: 
54
Общо: 
72

    Разпределение по вид на урока
Нови знания: 
18
Упражнения: 
45
Обобщениe и преговор 
4
Оценяване: 
5
Общо: 
72

 І. ОБЩО ПРЕДСТАВЯНЕ НА УЧЕБНАТА ПРОГРАМА

Учебната програма по Приложни програмни системи е предназначена за професия Програмист, специалност Системно програмиране. 

Съдържанието на предмета дава възможност на учениците да  получат основни знания и умения за въвеждане и обработка на текстови и числови данни посредством работа с текстообработващи системи и електронни таблици. Предметът дава основни знания за начините за представяне на информация пред публика чрез използване на програми за презентации. 

Учебното съдържание в програмата е структурирано в три раздела:

-  Разделът  Текстообработка включва знания за основните възможности на текстообработващите системи и тяхното използване като въвеждане и форматиране на текст, работа с таблици, поместване на графични обекти, подготовка на документ за печат. Дава знания за работа със специализиран редактор на формули и текст, с коректор на правописни грешки и речници. 

- Разделът  Електронни таблици обхваща технологията на създаване на електронни таблици. Включва знания за използване на вградени функции при създаване на формули, абсолютно и относително адресиране, графично представяне на данни посредством диаграми. Създава умения за използване на таблица като база данни. Включва знания за създаване и работа с макроси, създаване и използване на шаблони, на защита срещу случайни и неправомерни промени, пренос на данни между различни приложения.  

- Разделът  Компютърни презентации включва знания за етапите при подготовка и изграждане на компютърна презентация, избор на общ визуален стил, графични обекти, мултимедийни ефекти и др.

Обучението по учебния предмет за професия Програмист има затвърждаващ и надграждащ характер и се извършва във взаимовръзка с учебните предмети “Информатика” и “Информационни технологии” от задължителната общообразователна подготовка. Придобитите знания са базови и имат връзка с всички предмети от отрасловата и специфичната професионална подготовка.

Формирането на професионалните компетенции по предмета е на основата на усвояването на знания и умения, свързани с избор на подходящ приложен софтуер с цел структуриране и обработване на информацията според желанието  на потребителя. Обучението по предмета Приложни програмни системи развива умения за самостоятелна работа на учениците и работа в екип. Изгражда качества като прецизност, комбинативност, съобразителност, умения за вземане на решения. Създава трайни навици у учениците да боравят с техническа литература, да следят най-новите постижения в областта на   компютърната технология в компютърните издания – вестници,  списания  и Интернет.  

ІІ. ЦЕЛИ  НА  ОБУЧЕНИЕТО  ПО  МОДУЛА

Обучението по предмета има за цел чрез усвояване на знания и умения учениците да придобият професионални компетенции за използване на приложен софтуер. 

За постигане на основната цел на обучението по  Приложни програмни системи  е необходимо изпълнението на следните подцели:

· придобиване на знания и умения за въвеждане и форматиране на текст;

· придобиване на знания и умения за вмъкване на символи и създаване на списъци;

· придобиване на знания и умения за писане на математически формули;

· придобиване на знания и умения за работа с графични обекти;

· придобиване на знания за различните типове данни;

· придобиване на знания за използване на вградени функции за обработка на данни;

· придобиване на умения за създаване на диаграми;

· придобиване на знания за създаване на макроси;

· придобиване на знания и умения за пренос на данни между различни приложения;

· придобиване на умения за структуриране на информацията и създаване на компютърна презентация;

· изграждане на нагласа за самостоятелна творческо-познавателна дейност с компютърна  литература.

ІІІ. РАЗПРЕДЕЛЕНИЕ НА УЧЕБНОТО ВРЕМЕ

Общият брой часове за обучение по учебния предмет Приложни програмни системи и разпределението им по учебни години и срокове е записано в учебния план на професия Програмист, специалност Системно програмиране. Препоръчителното разпределение по раздели, съгласно учебната програма е:
	Раздел I. Текстообработка
	30

	Раздел II. Електронни таблици
	30

	Раздел III. Компютърни презентации
	12


ІV. УЧЕБНИЦИ И УЧЕБНИ ПОМАГАЛА 

1. Асенова, П., Ст. Иванов, К. Марчева, Р. Лишкова. Информационни технологии 9.клас задължителна подготовка. – С., Регалия 6, 2002.

2. Иванов, И., С. Кънчева. Информационни технологии за ІХ и Х клас. – С, Нова звезда, 2001.

3. Ангелов, А. Учебна среда за обучение по текстообработка. София, Сиела, 2003.
4. Ангелов, А. Учебна среда за обучение по електронни таблици. София, Сиела, 2004.
V. УЧЕБНО СЪДЪРЖАНИЕ
	№ по ред
	ТЕМА


	Бр. часове
	Уч. седм.
	Орг. форма
	Очаквани резултати

Възможности за междупредметни връзки
	Забе-лежка

	
	
	НЗ
	Упр
	Прег., обоб 

и оцен.
	
	
	
	

	
	Раздел I. Текстообработка – 30 ч.
	
	
	
	
	
	За целия раздел - връзка с Информатика и Информационни технологии
	

	1. 
	Въведение  в  предмета. 

Инструктаж по правила за безопасност и вътрешен ред. 

Входящ тест
	
	
	1
	1
	клас
	Кратко въведение в същността на предмета и съдържанието му. Информиране за учебниците и учебните помагала. Начален инструктаж по техника на безопасност, ППО и правилата за поведение в час. 
Оценка и анализ на входното ниво 
	

	2. 
	Прозорец на WORD. Работа с файлове.

· Основен прозорец на WORD, менюта, ленти с бутони.

· Отваряне и съхранение на файлове на текстови документи.
	1
	
	
	1
	клас
	Ученикът: 1.Познава структурата на работния екран и превключва между отделните области; 2. Познава основните команди и клавишни комбинации; 3.Работи с мишка; 4.Търси и получава помощна информация; 5. Умее да настройва работната среда 6.Отваря текстов документ и записва документ на диск от средата на текстообработващата система. 
	

	3. 
	
	
	1
	
	2
	гр.
	
	

	4. 
	Въвеждане и редактиране на текст.

· Въвеждане и редактиране на текст – избор на шрифт, размер, подравняване. Избор на стил: Bold, Italic, Underline.

· Маркиране на символ, дума, ред, абзац. Преместване и копиране на текст. 
	1
	
	
	2
	клас
	1.Познава структурата на текста.

2.Въвежда и поправя допуснати грешки;

3.Маркира основните структурни единици;

4.Извършва преместване, копиране, изтриване и вмъкване на маркиран текст.

Връзки: Български език, Чужди езици, Математика
	

	5. 
	
	
	2
	
	3
	гр.
	
	

	6. 
	Форматиране на текст

· Формат Font. 

· Формат Paragraph.

· Работа с текстова кутия Text Box.
	1


	
	
	4


	клас
	1. Форматира текста на ниво символ, като  познава и използва всички възможности на  диалоговата кутия от менюто Format>Font;
2.Форматира абзац, като  познава и използва всички възможности на  диалоговата кутия от менюто Format>Paragraph;

3. Вмъква, редактира, форматира и мести текстова кутия.
	

	7. 
	
	
	3
	
	4

5
	гр.
	
	

	8. 
	Добавяне на списъци и символи. Създаване на специализиран текст.

· Bullets and Numbering.

· Insert Symbol.

· Редактор на формули.
	1
	
	
	6
	кл.
	1. Използва автоматично номериране на подредени списъци и автоматично поставяне на символа при неподредени списъци. Форматира номерирането и символите. Сортира списъци по азбучен ред.
2 Вмъква символи и специални знаци в текста: Insert>Symbol

3. Вмъква математически формули в текста чрез аплета на MS Office - Equation Editor или програмата MathType
	

	9. 
	
	
	1

1
	
	6

7
	гр.
	
	

	10. 
	Таблици.

· Създаване и редактиране на таблици.
	1
	
	
	7
	кл.
	1. Вмъква таблици чрез Insert Table или ги чертае с молива и гумата от инструменталния ред Tables and Borders.
2. Управлява свойствата на таблицата чрез Table Properties
3. Маркира таблица или отделни нейни елементи. Изтрива таблица.
4. Редактира структурата на таблица: промяна широчината на колони и височината на редове, разпределяне широчината или височината равномерно, вмъкване или изтриване на редове, колони или клетки, обединяване или разцепване на клетки, 
5. Форматира хоризонталното и вертикалното подравняване на текста в клетките, ориентацията на текста

6. Превръща текст в таблица и обратно- таблица в текст
	

	11. 
	
	
	2
	
	8
	гр.
	
	

	12. 
	Таблици.

· Borders and Shading.

· Многоколонен текст.
	1
	
	
	9
	кл.
	1.Управлява рамките на клетките: вид на линията, дебелина, цвят, страна на клетката, към която се прилага.

2.  Управлява запълването на клетките с цвят и шарка
3. Прилага и управлява многоколонен текст
	

	13. 
	
	
	1
	
	9
	гр.
	
	

	14. 
	Автоматично коригиране на текст.

· Търсене и заместване на текст.

· Spelling.
	
	1
	
	10
	гр.
	1. Търси текст, като задава различни критерии за точност на съответствие като главни и малки букви, цяла дума или част от дума, форматиране, език и др. Търси управляващи символи като край на абзац, край на раздел, табулация и др.
2. Замества намерен текст или/и управляващи символи с желан текст или/и управляващи символи.
3. Задава език на документа. Извършва автоматична проверка на правописа. 
	

	15. 
	Работа с графични обекти.

· Clip Art.

· WordArt.

· Създаване на графични елементи.

· Обработване на графични елементи.
	1


	
	
	10


	кл.
	1. Вмъква графични обекти в текста: от файл, от библиотеката с изображения Clip Art, художествен текстWordArt, геометрични фигури, автофигури.
2. Редактира и форматира графичните обекти. Мести, копира,  разтяга, завърта, обръща огледално графични обекти. Сменя цвета на контура и цвета на запълването.
3. Използва групиране, подравняване  и равномерно разпределяне на няколко обекта. Прилага сенки и тримерни ефекти.
	

	16. 
	
	
	2
	
	11
	гр.
	
	

	17. 
	Създаване и форматиране на базов документ (template).
	1
	
	
	12
	кл.
	Създава, редактира и форматира базов документ (макетен файл, образец). Използва базов документ при създаване на нови документи.
	

	18. 
	
	
	1
	
	12
	гр.
	
	

	19. 
	Подготовка на документ за печат.

· Page Numbers.

· Header and Footer.

· Бележки под линия и забележки.

· Формат на страница.

· Предварителен изглед.

· Отпечатване на страница.
	1
	
	
	13
	кл.
	1. Номерира автоматично страниците.
2. Настройва горния и долния колонтитул

3. Умее да поставя бележки под линия и забележки

4. Форматира страница: размер, полета, ориентация, огледално обръщане на полетата, размер на горния и долния колонтитул;  управление на показването на първа страница и четни/нечетни страници. 
5. Показва  предварителен изглед на страницата
6. Настройва параметрите на печата.
	

	7. 
	
	
	1

1
	
	13
14
	гр.
	
	

	20. 
	Преговор и обобщение върху раздел Текстообработка
	
	
	1
	14
	гр.
	1. Затвърждаване на знанията по текстообработка 

2. Обобщаване и систематизиране 


	

	21. 
	Практически тест върху раздел Текстообработка
	
	
	2
	15
	гр.
	1. Мотивиране на учебната дейност

2. Проверка на знанията и уменията по текстообработка
	

	
	Раздел II. Електронни таблици
	
	
	
	
	
	Връзка с Информатика, Информационни технологии и Математика
	

	22. 
	Прозорец на Excel.

· Основен прозорец на Excel. Менюта, ленти с бутони, работни листа и книги.

· Настрoйване на средата на Excel. Работа с няколко прозореца. Създаване на потребителски изгледи.
	1
	
	
	16
	кл.
	1. Познава структурата на ЕТ - екранно таблично пространство и елементите му.
2. Настрoйва средата на Excel: списък на последно използвани файлове, брой листи в нов документ, местоположение на файловете, мерни единици, автоматично съхраняване и др. Показва и скрива инструментални редове. Настройва опциите за автокоригиране и автоформатиране.
3.Съхранява създадена таблица във файл и зарежда таблица от файл.
4. Работи с няколко прозореца

	

	23. 
	
	
	1
	
	16
	гр.
	
	

	24. 
	Въвеждане и редактиране на данни. Работа с работни листове

· Въвеждане и редактиране на данни: текст, числа и дати.

· Маркиране на клетки, колони, редове, работни листа.

· Преместване, копиране, търсене и заместване на данни.  
	1
	
	
	17
	кл.
	1. Проектира и създава таблица 
2. Въвежда различни типове данни – текст, дата и час, числа в различен фор​мат;
3. Маркира чрез мишката или чрез клавишни комбинации клетки, колони, редове, работни листа

4. Редактира въведени данни, премества, копира, изтрива и вмъква данни;

5. Извършва търсене и замяна в ЕТ
	

	25. 
	
	
	1

1
	
	17

18
	гр.
	
	

	26. 
	· Вмъкване, изтриване и разместване на клетки, редове и колони.

· Скриване и разкриване на колони, редове и работни листа.

· Замразяване на колони и редове.
	
	1
	
	18
	гр.
	1. Редактира структурата на таблица: промяна широчината на колони и височината на редове, вмъкване,  изтриване или разместване на редове, колони или клетки, обединяване на клетки. 
2. Скрива и разкрива колони и редове. 
3. Замразява (freeze) и размразява колони и редове
4. Маркира, вмъква, изтрива, копира,  мести, преименува и оцветява листи.
	

	27. 
	Форматиране на редове, колони, диапазони от клетки.
	1


	
	
	1
	кл.
	1. Форматира основни структурни еди​ници в ЕТ (клетка, ред, колона);

2.Форматира различни типове данни (текст, числа и др.);


	

	8. 
	
	
	1

1
	
	1

2
	гр.
	
	

	28. 
	Формули. Създаване и редактиране на формули.
	
	1
	
	2
	гр.
	1.Извършва аритметични операции в ЕТ; Съставя и редактира формули за изчисление;
2. Копира формули в множество клетки чрез влачене.

3. Използва оператор за конкатенация на текстови низове.
Връзки: Математика
	

	29. 
	Използване на вградени функции.
	
	1
	
	3
	гр.
	1. Работи с често използвани вградени функции: Sum, SumIf, Average, Count, CountA, CountIf, Max, Min, 
2. Работи с логически функции: If, AND, OR, NOT.

Връзки: Математика, Програмиране І част
	

	30. 
	Преместване и копиране на формули. Използване на абсолютни и относителни адреси.
	
	1
	
	3
	гр.
	1. Използва абсолютна, относителна и смесена адресация на клетки във формули и функции.

2. Копира и мести формули чрез клипборда или менюто Edit > Fill
	

	31. 
	Създаване и редактиране на сложни формули с вложени функции и аргументи от различни работни листи и книги.
	1
	
	
	4
	кл.
	1. Създава и редактира сложни формули с вложени функции и аргументи от различни работни листи и книги.
2. Затвърждава уменията за работа с логически функции: If, AND, OR, NOT.
	

	32. 
	
	
	1
	
	4
	гр.
	
	

	33. 
	Функции за търсене и многовариантен избор: VLOOKUP, HLOOKUP, LOOKUP, CHOOSE
	1
	
	
	5
	кл.
	Познава начина за работа с функции за търсене и многовариантен избор: VLOOKUP, HLOOKUP, LOOKUP, CHOOSE
	

	34. 
	
	
	1
	
	5
	гр.
	
	

	35. 
	Диаграми.

· Създаване на диаграма.

· Модифициране на диаграмата.

· Модифициране на елементи на диаграмата.
	
	2
	
	6
	гр.
	1. Познава основните типове диаграми;

2. Използва вградените възможности на табличния процесор за създаване на диаграми от различен тип;

3. Включва надписи за скали, етикети, легенда, заглавие;
4. Модифицира елементи от диаграмата и цялата диаграма.
Връзки: Математика Икономическа география, Физика, Биология, Химия - диаграми за серии от данни
	

	36. 
	Използване на таблицата като база данни.

· Сортиране на данни.

· Филтриране на данните.

· Създаване на частични суми.
	
	1
	
	7
	гр.
	1. Сортира данни по зададени критерии.
2. Филтрира данни чрез автоматичен филтър и разширен филтър.

3. Създава частични суми


	

	37. 
	Подготовка на документ за печат.

· Настройки на параметрите на страница.

· Header and Footer.

· Предварителен изглед. Отпечатване на  страница.
	1


	
	
	7


	кл.
	1. Настройва параметрите на страница за отпечатване: размер на листа, ориентация, мащабиране, полета, центриране, повтарящи се редове и колони и др.
2. Настройва горния и  долния колонтитул.

3. Извършва основни настройки за печат и отпечатва таблици и диаграми.


	

	38. 
	
	
	1
	
	8
	гр.
	
	

	39. 
	Създаване и използване на шаблони.
	
	1
	
	8
	гр.
	Създава, редактира и форматира базов документ (шаблон, макетен файл, образец). Използва базов документ при създаване на нови документи.
	

	40. 
	Макроси. Създаване на командни макроси.
	
	2
	
	9
	гр.
	1. Знае същността и приложението на макросите.

2. Записва последователност от действия като макрос. Присвоява на макроса клавишна комбинация и команден бутон.
	

	41. 
	Импортиране и експортиране на данни в и от други програми.
	
	1
	
	10
	гр.
	1. Обяснява същността на технологията OLE, разликата между вграждане и свързване на обекти.
2. Импортира и експортира данни в и от други програми чрез вграждане или свързване.
	

	42. 
	Защита на клетки, работни листове и работни книги.
	
	1
	
	10
	гр.
	1. Познава и използва технологията за защита на клетки, листове и книги
	

	43. 
	Преговор и обобщение върху раздел Електронни таблици
	
	
	2
	11
	гр.
	1. Затвърждаване на знанията по електронни таблици
2. Обобщаване и систематизиране на знанията по електронни таблици
	

	44. 
	Практически тест върху раздел Електронни таблици
	
	
	2
	12
	гр.
	1. Мотивиране на учебната дейност

2. Проверка на знанията и уменията по електронни таблици 
	

	
	Раздел III. Компютърни презентации
	
	
	
	
	
	Връзка с Информатика, Информационни технологии и Изобр. изкуство
	

	45. 
	Основни правила при изготвяне на презентация. Създаване на презентация с Power Point.

· Прозорец на Power Point. 

· Дизайни и цветови схеми. 

· Шаблони с дизайни на слайдове.

· Режими на работа.
	1
	
	
	13
	кл.
	1.Познава основните възможности на съвременните ИТ за представяне на ин​формация пред публика 
2. Познава прав​ните и етични изисквания при открито представяне на информация.
3. Познава и настройва работната среда на Power Point.

4. Използва готови дизайни и цветови схеми на слайдове.
5. Получава идея за създаване на собствени  дизайни и цветови схеми на слайдове.
6. Познава и използва различните режими на работа с Power Point.
	

	9. 
	
	
	1
	
	13
	гр.
	
	

	46. 
	Вмъкване на обекти.

· Вмъкване на текст.

· Вмъкване на рисунки.

· Вмъкване на таблица.

· Вмъкване на диаграма.

· Ефекти с WordArt, AutoShapes и др.
	1
	
	
	14
	кл.
	1. Умее да вмъква, редактира и форматира различни текстови, таблични и графични обекти в слайдовете: текстови кутии, таблици, растерни изображения, векторни  обекти, художествен текст, диаграми, и т.н. 

2. Умее да мести, копира и изтрива обекти в слайдовете.
	

	47. 
	
	
	1

1
	
	14

15
	гр.
	
	

	48. 
	Настройки на презентацията.

· Вмъкване, изтриване и разместване на слайдове.

· Режим на смяна на слайдовете.

· Начин на появяване на слайдовете.
	
	1
	
	15
	гр.
	1. Умее да вмъква, мести, копира и изтрива слайдове в презентацията.
2. Задава режим на автоматична или ръчна смяна на слайдовете.

3. Задава анимационни ефекти при преход към следващ слайд.
	

	49. 
	Мултимедийни инструменти.

· Анимация.

· Вмъкване на звук.
	1
	
	
	16
	кл.
	1. Познава анимационните ефекти, прилагани към обекти от слайдовете.
2. Използва подходящи анимационни ефекти при появяване и изчезване на обект, както и за обръщане внимание върху видим обект. Задава движение на обекти по траектория.
3. Вмъква звук и управлява начина за изпълнението му: сила, повторение, начин на започване (автоматично, при щракване на иконата на говорителчето или при щракване на друг обект), начин на прекратяване (при щракване на иконата, при излизане от слайда или след определен брой слайдове).
4. Получава идея за вмъкване на видеоклипове и флаш анимация
	

	50. 
	
	
	1
	
	16
	гр.
	
	

	51. 
	Практическо изпитване върху раздел Презентации
	
	2
	
	17
	гр.
	1. Затвърждаване на знанията по Компютърна презентация

2.  Мотивиране на учебната дейност

3. Проверка на знанията и уменията. Създава компютърна презентация по определена тема, като прилага изучените техники за работа с презентации. 
	

	52. 
	Отпечатване на презентация. Преговор и обобщение върху раздел Презентации
	
	1
	
	18
	гр.
	1. Познава настройките за отпечатване на презентация. 
2. Обобщаване и систематизиране на знанията по презентации
	

	53. 
	Годишен преговор. Тест за проверка на изходното ниво. Оформяне на годишните оценки
	
	
	1
	18
	гр.
	Обобщаване и систематизиране Проверка на знанията в края на обучението по Приложни програмни системи.
	


VІ. ОЧАКВАНИ  РЕЗУЛТАТИ ОТ ОБУЧЕНИЕТО

В  края на обучението учениците трябва:

да знаят:
· основните прозорци на програмите за текстообработка, електронни таблици и презентации;

· основните менюта и ленти с инструменти;

· основните елементи от работното пространство на програмните среди;

· различните типове данни;

· основните вградени функции при създаване на формули;

· разликата между относително и абсолютно адресиране;

· етапите при създаване на компютърни презентации.

да могат:

· да работят с текстообработващи системи;

· да вмъкват символи и създават списъци;

· да изписват математически формули;

· да работят с графични обекти;

· да обработват числови данни;

· да създават диаграми;

· да създават макроси;

· да създават и използват шаблони;

· да осигуряват защита на данните;

· да обменят данни между различни приложения;

· да създават компютърни презентации.
VІІ. СПЕЦИФИЧНИ МЕТОДИ И ФОРМИ ЗА ОЦЕНЯВАНЕ НА ПОСТИЖЕНИЯТА НА УЧЕНИКА.

По време на учебния срок учителят осигурява ритмичност при оценяването на всеки ученик в съответствие с Наредба №3 за системата на оценяване. Минималният задължителен брой текущи оценки за срока е - две оценки от устни изпитвания и една оценка от практическо изпитване. Тъй като учебният предмет  се изучава по 2 часа седмично през двата срока, оформят се срочни оценки за І и ІІ срок и годишна оценка.

Оценяват се знания, умения, компетенции и отношение на учениците, както на основата на текущи оценки, така и в края на изучаваните раздели. Могат да се използват различни форми на оценяване:
1. Устно изпитване – в диалог с ученика учителят преценява способността му да обяснява преподадените понятия и умението да ги използва при решаване на конкретен проблем.

2. Тестово изпитване чрез тестове с многовариантен избор, попълване на празно място, въпроси с ДА/НЕ и др. 

3. Писмено изпитване.
4. Практическо изпитване.

5. Оценяване на работа по проект
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